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Limpeza Verificacdo Sistemna da Pds Producdo

L Purge Sketchup Volumetria Ajustes de intensidade
F Wipe V-ray Detalhes Filtros

Material ID Texturas Especificas
V

Save e Repath luminacs
| Layers Certos umlnlagao

Dia — com luz natural
1
A Enquadramento Texturas e Materiais
] Padrdo Realista

S Importar base lev

Angulo Acabamento e Render Final

Verificacdo da Lente Configuracdo para boa resolucdo

Linhas perpendiculares




Limpeza

Model Info & n
Animation Entire model v [[]show nested components
3 Classifications
1- Limpeza no Sketchup Coponeris: M\ Count ~
Dimensions Edges 0
QO Clique no Menu Window e escolha Model Info G oo il o
ST | i o
[ Escolha na lateral esquerda “Statistics” B Gude s 0
Groups 9
: 7] " B " Images 0
O Clique em “Purge Unused” e depois “Fix Problems” e -
Section Planes 0
Dimensions 0
Text 0 v
Purge Unused 7 Fix Problems
l ]




Limpeza

2—- Limpeza no V-Ray

O Clique no Menu Extensions e escolha V-Ray

W 2uk 00_Cozinha_R00.skp - SketchUp Pro 2012

File Edit View Camera Draw Tocls Window = Extensions Help
n / b SketchUV > I\ 7 B fa) =
M D4LE VOL e P A vl s & Al e
NS il T FilePathEditor

: Frame Buffer

V-Ray Rendering
V-Ray Lights
V-Ray Objects
Tools

Y v v o~

Light Intensity Tool

Camera Focus Toel

Wipe V-Ray data from project
Randomize Project Matsrial IDs

Pack Project

O Em seguida escolha Tools > Wipe V-Ray data from Project

0BS. Ao fazer isso ele vai “resetar” todos as configuragdes do V-
Ray, portando faca somente no INICIO do projeto depois que a
modelagem e verificacdo estiverem prontas.

Q Clique em SIM 2X

QO Clique depois também em Randomize Project Material Ids no

GPU Device Selection

@ Aulz 00_Cozinha_R0D.sko - SketchlUp Pro 2012
File Edit View Camera Draw Tools Window Extensions Help

f‘ R @ d 1; v'bé SketchUV r N ‘7“’2"“’71"'_'[:\& @"(j

¥-Ray * Asset Editor
[N i v File Path Editor
ES Frame Buffer
ﬁig V-Ray Rendering >
/ S’ V-Ray Lights y
V-Ray Objects 3
"j g Tools > Light Intensity Tool

Camera Focus Toel

mesmo caminho que o anterior

@ @ Pack Project
- Wipe ¥-Ray data from project
it = Randomice Prejec Mt 03
i GPU Device Selection




Enquadramento

Enquadramento
Clique no icone do V-Ray @‘

Escolha Settigns

3-
d
u
1 Importe o arquivo Base Render que criamos no MODULO 02
d
d
d

Para importar € s0 clicar na pasta abaixo
Procure o arquivo que vocé fez o download

E clique em Abrir

) v-Ray Asset Editor




Enquadramento

4- Enquadrando com Corte

Q) Para melhorar o enquadramento faca um corte com a
ferramenta do Sketchup _@Q

O Posicione o plano de Corte

Q Desligue o plano de Corte &

OBS. Cuidado para ndo desligar o corte em si, somente 0
plano para ndo atrapalhar nas outras fungdes




Enquadramento

s % Aula 00_Cozinha_RO0.skp - SketchUp Pro 2008
5~ Enquadramento [ e e
. Mext
i Dimersians o | 1 Sendund i »
(1 Vana aba Render Output {; @
| Perspective
1 Ligue o botdo Safe Frame S " «
m E Edltla’etc}’ctllh::l.:l
J Mude o Aspect Ratio para Square== @8 o ;
J& - :
L Ajuste a altura do observador e a distor¢do da lente = 30° N S
. . N o & & Zoom Extents Cur-Shit £
1 Certifique que as linhas estdo verticais escolhendo no menu o
. . . Position Camera
(Camera a opcao > Two Point Perspective 3 Wek
ﬁ %’\ " Look Around
L Adicione um nova cena | o




Verificacao

6— Volumetria

O Verifique se na sua volumetria pode melhorar algum ponto
no realismo da sua cena inserindo elementos como cantos

arredondados PR e e e
l do Open e Decispa
O Verifique também os possiveis erros de layers .
a Pade £}
O Coloque a canopla da luminaria e coloque dentro do : e 5
componente o == .
Q  Recorte 0 bloco da canopla 4_ o
Q  Entre dentro do componente da lumindria va em View e use o Paste in Place 3 WF
para colar no mesmo lugar 0
(74



lluminacao

7- lluminacdo Beomen - R

1 Configure o render para desconsiderar a luz que entra pelo
corte

(1 No Asset Editor clique em Geometry

Clique no Section Plane ativo

Desmarque a opcdo Affect Light

Marque a opcao Camera Rays Oy

oL O 0 O

Desmarque a op¢do Clip Light Geometry s



lluminacao

¢ o &
8- lluminacdo Diurna — Anulando os Materiais (menos 0 Vidro) [

b Camera

1 Na configuracdo de Settings, clique no botdo ligar do  ender Ouput
Material Override (aqui ele deixa o render numa cor Unica para [
fazer os testes de |uz) G

b Matenal Overnde

b Swarm

(1 Faca o vidro transparente para regularizar as configuracdes de luz
A  Com o conta-gotas, pegue o material do vidro
@ Quando abrir a edicdo do material coloque no maximo as barras nas abas

O Reflection e

BN

O Refration

@ ¥-Ray Asset Editor

3  Desmarque em Material Options a op¢do “Can be Overridden”




lluminacao

9- lluminagdo Diurna — Melhorando a intensidade da Luz
coma Camera

1 Na configuracdo de Settings, na aba Camera vocé pode mudar
0s valores de sensibilidade do filme da camera

Ly

Q  Coloque 0150 em 200 (quanto maior o valor mais claro) == T

O No Aperture (F Number) em 6 (quanto menor o valor mais claro)

Q  Eno Shutter Speed (1/5) em 50 (quanto menor o valor mais claro S
* Effects
0BS. (aso essa opgdes ndo estejam aparecendo clique nesse > Render Output
icone dos switches ao lado para liberar a edi¢da " Endrennent

* Matenal Overnde

[ Faca o teste de Render clicando no render interativo E




lluminacao

10~ lluminacdo Diurna — Luz de Apoio (Retangulo de Luz) — ""T‘ B — .

a
d

U

U

v a0 LightRectangle
s O

~ Main

Crie um Retangulo de Luz com o icone
Posicione na parte externa do vao da janela

Certifique que a ?arte branca (em que a iluminacdo vai “acender” esteja A - '
voltada para dentro do ambiente. : v ek ~ Opions

"Se ndo estiver, vocé pode clicar com o botdo direito do mouse em cima do retangulo de luz, escolhe Flip Along>
Component’s Blue

Configure a intensidade do retangulo para 20

Deixe o retangulo invisivel

Coloque a Cortina em um Layer separado, desligue esse layer e atualize a
cena, para ndo atrapalhar no blogueio da luz

» Caustic photons

Faca o teste de render com o Render Interativo B

|OBS o tamanho do retangulo de luz influencia também na intensidade da
uz




lluminacao

12— lluminagdo Diurna — 2 Luz de Apoio (Retangulo de Luz)

Q

Q

U

U 0 0 O

~

‘Ij_lf @ ﬁ) 531’3 E LightRectangle

¥ Main

Crie um Retangulo de Luz com o icone ' agora do outro lado do
quarto, para ter uma luz vindo tanto da esquerda quanto da direita

Posicione na parte da esquadria
¥ Options
Certifique que a parte branca (em que a iluminagdo vai “acender” esteja
voltada para dentro do ambiente.

*Se ndo estiver, vocé pode dicar com o boto direito do mouse em cima do retdngulo de luz, escolhe Flip Along>
Component’s Blue

Configure a intensidade do retangulo para 20
Deixe o retangulo invisivel
Faca o teste de render com o Render Interativo @ ) i

OBS o tamanho do retangulo de luz influencia também na intensidade da
luz




Texturas e Materiais

@ V-Ray Asset Editor

1-MADEIRA DA PAREDE -BIBLIOTECA DO V-RAY

O Va para a biblioteca de materiais do V-Ray e escolha a aba WOOD & LAMINATE
O  Selecione o material “Veneer B01_120cm”

O C(lique com o botdo direito e adicione o material na cena

d

Copie o material recém adicionado clicando com o botdo direito em cima dele e dé
um copy (ou “use as replacement”)

U

Va com o conta gotas, # e busque a referencia do material que vocé quer
substituir no caso a parede de madeira

O Com o material antigo selecionado, clique com o botdo direito e escolha “Paste” (
Ou “Replace”)

Q  Verifique a escala do objeto

O (aso 0 objeto ndo carregue no V-Ray, dique novamente com o conta-gotas # no
material do Sketchup para recarregar a visualizacdo




Texturas e Materiais

@ V-Ray Asset Editor

2-DETALHE METALICO DOURADO DA PAREDE -BIBLIOTECA DO V-RAY —
Va para a biblioteca de materiais do V-Ray e escolha a aba METAE: : == ‘ "5‘_:51
Selecione o material “Copper_Blurry” ' ~ ‘ ' B
(lique com o botdo direito e adicione 0 material na cena

CoPie 0 material recem adicionado dlicando com o botdo direito em cima
dele e dé um copy (ou “use as replacement”)

Va com o conta gotas, e busque a referencia do material que vocé
quer substituir o caso a cor do detalhe na parede

Com onmaterialuanti%o selecionado, clique com o botdo direito e escolha
Paste”  ( Ou “Replace”)

O O O 0O00OD0

(aso 0 objeto ndo carregue no V-Ray, clique novamente com g conta-
gotas »~ no material do Sketchup para recarregar a visualizacdo




Texturas e Materiais

@) v-Ray Ascet Editor

3—-CONCRETO DA PAREDE -BIBLIOTECA DO V-RAY
O Vapara a biblioteca de materiais do V-Ray e escolha a aba CONCRETE

Selecione 0 material “Concrete_Reflective AOT 2m”

<4
=
™
&
-
LR
@
-
=

d
Q  C(lique com o botdo direito e adicione o material na cena
d

Copie 0 material recém adicionado clicando com o botdo direito em cima dele e dé
um copy (ou “use as replacement”)

U

Va com o conta gotas, # e busque a referencia do material que vocé quer
substituir no caso a parede de concreto

O Com o material antigo selecionado, clique com o botdo direito e escolha “Paste”
( Ou “Replace”)

O Verifique a escala do objeto

Q  (aso 0 objeto ndo carregue no V-Ray, clique novamente com o conta-gotas # no
material do Sketchup para recarregar a visualizacdo



Texturas e Materiais

@) V-Ray Asset Editor

4-PI1S0 DE MADEIRA -BIBLIOTECA DO V-RAY
O Va para a biblioteca de materiais do V-Ray e escolha a aba WOOD & LAMINATE

Selecione o material “Flooring_Parquet_Parallel_B01_120cm”

=]
P
WP
Eo
-
P
W\
-]
W

d
Q  Clique com o botdo direito e adicione o material na cena
Q

Copie 0 material recém adicionado clicando com o botdo direito em cima dele e dé
um copy (ou “use as replacement”)

(M

V4 com o conta gotas, #* e busque a referencia do material que vocé quer
substituir no caso o piso de madeira

Q Com o material antigo selecionado, clique com o botdo direito e escolha “Paste” (
Ou “Replace”)

O Verifique a escala do objeto

O (aso 0 objeto ndo carregue no V-Ray, clique novamente com o conta-gotas # no
material do Sketchup para recarregar a visualizacdo




Texturas e Materiais

5-COURO CARAMELO-BIBLIOTECA DO V-RAY

Q

Q
Q
Q

(W

O O

Va para a biblioteca de materiais do V-Ray e escolha a aba LEATHER
Selecione o material “Leather_D01_Brown_25cm”
Clique com o botdo direito e adicione o material na cena

Copie o material recém adicionado clicando com o botdo direito em cima dele e dé um copy (ou
use as replacement”)

V4 com o conta gotas #” e busque a referencia do material que vocé quer substituir no caso o
(ouro

Com o material antigo selecionado, clique com o botdo direito e escolha “Paste” ( Ou “Replace”)
Verifique a escala do objeto

Caso 0 objeto ndo carregue no V-Ray, cique novamente com o conta-gotas #* no material do
Sketchup para recarregar a visualizacdo

Quando o material carregar no Sketchup vocé vera uma cor diferente (uma textura azul) vocé
pode regularizar a cor mexendo no S e H na aba EDIT dos materiais no Sketchup, isso ndo

@ V-fey Asset Editor

¥ Mateniads . -

. Leather_LO1_Eremn_25am

& o

Texture

] U b tre prasge
Leater D N4, 100 “ v
- | 254m } l [ Colorize
¥ [250n . Rezet Coor

influencia no material configurado no render.



Texturas e Materiais

6— MADEIRA PRETA CABECEIRA DA CAMA

 Clique com o conta-gotas do Sketchup e ele ja carrega o
material no V-Ray

(d Abra a aba Reflection, e arraste a barra do Reflection Color até
o final, ele ja vai criar uma “pelicula de brilho” no material

(1 Para deixar acetinado, clique diminua a barra do Reflection
Glossiness até 0,65

{b. ,:_"] Layered Material

¥ VRayBRDF

() T ¢
W, A\ <
Venear_D0Z_120cn
\
|

¥ Reflachon




Texturas e Materiais

/- LACA GRAFITEDO CRIADO MUDO

Clique com o conta-gotas do Sketchup e ele ja carrega o
material no V-Ray

O Abra a aba Reflecfion, € arraste a barra do Reflection Color até
0 final, ele ja vai criar uma “pelicula de brilho” no material

(1 Para deixar acetinado, clique diminua a barra do Reflection
Glossiness até 0,7

(e°n) ('-CP @ {}

R =1  Layered Material
® B -

~ VRayBROF

v Diffuse




Texturas e Materiais

8- TECIDO DO LENCOL CINZA

O Clique com o0 conta-gotas do Sketchup e ele jd
carrega o material no V-Ray

O (lique nos quadradinhos do Difuse
O Escolha Falloff

O Faca um mix de 2 cores:

O  Sendo o Color A a cor predominante do tecido (cinza escuro)

Q EoColor Ba cor do brilho do tecido (geralmente um tom
mais claro do que a cor predominante

O Clique em Back

O Para tirar a marca do V-ray, va no material do
Sketchup e desabilite o Use Texture image. Mude
também a cor.




Texturas e Materiais

AR

9—-ROUPA DE CAMAAZUL-BIBLIOTECA DO V-RAY : | B >
O  Vaparaa biblioteca de materiais do V-Ray e escolha a aba FABRIC

Selecione o material “Fabric_F02_MilitaryGreen_40cm”

a
O  Clique com o botdo direito e adicione o material na cena
a

Copie 0 material recém adicionado clicando com o botdo direito em cima dele e dé um copy (ou}s=
use as replacement”) ;

O  Vacom o conta gotas /e busque a referencia do material que vocé quer substituir no caso o Bbhi—]
lenol azul : . e
¥y v Sy ~
O  Com o material antigo selecionado, clique com o botdo direito e escolha “Paste” ( Ou “Replace”) ; : — g o d
_ . § Pckes: HeB 4 X
O  Mude a cor do tecido de verde para azul, na cor do Difuse no Layer BRDF - I
s [
0O  Caso 0 objeto ndo carregue no V-Ray, clique novamente com o conta-gotas #* no material do S p—. 2%
Sketchup para recarregar a visualizacdo i .
Faoz F_NA.pg ‘V
O Quando o material carregar no Sketchup vocé vera uma cor diferente (uma textura azul) vocé T P
pode regularizar a cor mexendo no S e H na aba EDIT dos materiais no Sketchup, isso ndo ovaty :
influencia no material configurado no render. —| > :



Texturas e Materiais

@ V-Ray Asset Editor

10—MANTA CINZA -BIBLIOTECA DO V-RAY

O Va para a biblioteca de materiais do V-Ray e escolha a aba FABRIC
O Selecione o material “Wool_D1_20cm”

(ligue com o botdo direito e adicione o material na cena

Q

Copie 0 material recém adicionado clicando com o botdo direito em cima dele e dé
um copy (ou “use as replacement”)

U

Va com o conta gotas, # e busque a referencia do material que vocé quer
substituir no caso a manta cinza

Q  Com o material antigo selecionado, clique com o botdo direito e escolha “Paste” (
Ou “Replace”)

O Verifique a escala do objeto

Q  (aso 0 objeto ndo carregue no V-Ray, clique novamente com o conta-gotas ## no
material do Sketchup para recarregar a visualizacdo




Texturas e Materiais

11— CABO DA LUMINARIA

Q Clique com o conta-gotas do Sketchup e ele ja carrega o
material no V-Ray

(1 Abra a aba Reflection, e arraste a barra do Reflection Color afe
0 final, ele ja vai criar uma “pelicula de brilho” no material

(O Para deixar acetinado, clique diminua a barra do Reflection
Glossiness até 0,5

{b [j Layered Matenal

~ VRayBRDF

v Diffuse

* Anisotropy

* Dim Distance
} Refraction
¥ Opacity

» Advanced Options




Texturas e Materiais

@ V-Ray Assct Editor — X

O Ea {:} Y @ E—‘] Layered Material

~ VRayBRDF

v Diffuse

12— ALCA DE MADEIRA DA LUMINARIA

Q1 Clique com o conta-gotas do Sketchup e ele ja carrega o
material no V-Ray

~ Reflection

O Abra a aba Reflecion, € arraste a barra do Refection Color are
o final, ele ja vai criar uma “pelicula de brilho” no material

(O Para deixar acetinado, clique diminua a barra do Reflection
Glossiness até 0,75

¥ Anisotropy

» Dim Distance
» Refraction
¥ Opacity

» Advanced Options




Texturas e Materiais

@ \-Ray Asset Editor

13— CROMADO DA LUMINARIA

Q Clique com o conta-gotas do Sketchup e ele ja carrega o
material no V-Ray

O Abra a aba Reflection; € arraste a barra do Reflection Color are
o final, ele ja vai criar uma “pelicula de brilho” no material

L Desmarque a opcdo do Fresnel

i Layered Material

* VRayBRDF




Texturas e Materiais

14-METAL MANCHADO DOURADO DO ADORNO
O Vapara a biblioteca de materiais do V-Ray e escolha a aba METAL

3 Selecione o material “Metal_Weathered_S02_20cm”
Clique com o botdo direito e adicione o material na cena
4

Copie o material recém adicionado clicando com o botdo direito em cima dele e dé
um copy (ou “use as replacement”)

U

Va com o conta gotas, # busgue a referencia do material que vocé quer
substituir no caso o metal do adorno

3 Com o material antigo selecionado, clique com o botdo direito e escolha “Paste” (
Ou “Replace”)

3 Verifique a escala do objeto

3 Caso 0 objeto ndo carregue no V-Ray, clique novamente com o conta-gotas / no
material do Sketchup para recarregar a visualizacdo




Texturas e Materiais

@ v-Ray Asset Editor - X

L
l:lr (‘P @ {;} {':]/ i Layered Material
khung tranl

¥ VRayBRDF

¥ Diffuse

15— MOLDURAS DOS QUADROQS

Q Clique com o conta-gotas do Sketchup e ele ja carrega o
material no V-Ray

1 Abra a aba Reflection, e arraste a barra do Reflection Color afe
o final, ele ja vai criar uma “pelicula de brilho” no material

(1 Para deixar acetinado, clique diminua a barra do Reflection
Glossiness até 0,8

» Anisotropy
» Dim Distance

¥ Refraction

» Opacity

* Advenced Options




Texturas e Materiais

16— CORTINA BRANCA

O  Nallista de Material, escolha para criar um material Genérico do
1e10

@\' Ray Asset Eddor X

) =

Y O

O BASE

a Coloque a cor branca

ad Renomeei o material com o nome Cortina Base

O  CORTINA

a Novamente na lista de material, clique para criar um novo material, agora escola

Two Sided

Q Renomeei ele com o nome Cortina TwoSided

d Cologue o material no material FRONT o Cortina_Base que Criamos———

a Cologue o material no material BACK 0 Cortina_Base Novamente sm——
O  Aplique esse material Cortina_Two Sided no bloco da Cortina

O Lembre-se de aplicar em todas as faces do bloco, inclusive dentro

Y-Ray Asset Editor

A S o - ]
L‘.hf’ E\L) ’;1 M | Two Sided Matenial

» Matenal Chtions




Acabamento e Render Final

) V-Ray Asset Editor - *

17-Teste de render com os materiais ativos

L Depois de configurar os materiais, clique nas configuracdes
do Render

* Camera

¥ Render Output

1 Desligue o Render Interativo

* Animation
* Environment

L Desligue o Material Override s O

*  Swarm

L Faca um teste de Render

1 Analise a imagem e corrija 0s possiveis erros




Acabamento e Render Final

@ V-Ray Asset Editor

@R ©8.. ,
18—Render Final + Renderer --

» Camera

* Render Output

 Clique nas configuracGes do Render

Dimensions

(1 Naaba Render Output

Q  Cologue a medida com 1920

O Ative 0 Save Image

Q  Escolha uma pasta para os arquivos do Batch b Image O tions
Render sejam salvos

¥ Animation
* Environment
(1 Naaba Raytrace

* Matenal Overnde

¥ Swarm

O Cologue o noise Limit em 0,02

O Max Subdivs em 12




Acabamento e Render Final

) V-Roy Asset Editor - X

(j) @ {:} \‘(;v E » Raytrace

~ Global lllumination

¥ Renderer

19—Render Final

Q Clique nas configuracbes do Render

J Na aba Irradiance Map

Q  Cologue o “Interpolation” com 50

» Erwirorment

D Na aba nght Ca(he » Matesial Override

» Swarm

Q  Coloque o “Subdivs” com 1200

* Ambient Ocdusion

» Caustics

» Yolumetric Environment
? Render Elements

¥ Switches




Acabamento e Render Final

&) V-Ray Assct Editer - 4

\‘;r—'i] D P Raytracs

* Global [llumination

¥ Caustics

20—Render Final = S —

> Render Elements

(1 Na aba Rende Elements coloque

O Material ID

D Raw I_lght » Render Output
P Animation ¥ Denoizer

O  Raw Reflection T p— P
r  Material Cverride <

3 Raw Shadow pE— r—

O Raw Total Light

U  Denoiser

1 Salve 0 Arquivo

(1 Renderize a Cena




Sistema de Pos Producao

21— IMPORTEAS IMAGENS DO RENDER ELEMENTS
 Clique em File > Scripts > Load Files into Stack...

1 Busque as imagens do download dessa aula clicando em

“Browser”

1 Carregue asimagens e dé OK




Sistema de Pos Producao

22— AJUSTES NO LAYERS DOS CANAIS — Raw Light

= 1 C(lique e arraste o Layer “Raw Light" para o topo da lista de
Layers

(1 Na lista de efeitos, escolha o “Soft Light”
1 Controle 0 “Opacity” para 25%

Layers Channels Path.
Saft Light w | Opacity: 25% |~
£ Kind wE @ T O ® ——

lock: BB # b TN @ Al 100% |~
F 1
ﬂ'-_.

Saft Light ~ | Opatity: | 25% | v
3 = O Quarta_1_Scene 1. Rawlight.
s B 2 3 & & Fill: | 100% | - Rl il

F 1
< .:# Quario_C1_Scene 1Rawlightpng
(==

"
*"  Quartn 01 Scene 1.0endiser.png

-

Quarto 01 Scane 1.Materialllong

Quarto 01 Scane 1.png




Sistema de Pos Producao

23— AJUSTES NO LAYERS DOS CANAIS — Raw Reflections

— 1 C(lique e arraste o Layer “Raw Reflections” para o topo da lista de
Layers

(1 Nallista de efeitos, escolha o “Soft Light”

1 Controle o “Opacity” para 24°

Bl e

Layers Channels Paths History
« | Opacity:  24%

& Kind ST T -
&= & 2 T L & ck: B & D B Fill: | 100% |~

Soft Light ~  Dpacity:  24% |
lock: B # b 0 @  Fill: 100% |~ c;)i'
o

%' Quartn 01 Scene 1.RawReflection.png

7 lﬂ Dhiarbn N1 Srona 1 Rawd icht oo
| T
—_—

.
LL Quartn_01_Scene 1.Denoiser.png

H  Quarto 01 Scene 1.MaterizliD.png



Sistema de Pos Producao

24— AJUSTES NO LAYERS DOS CANAIS — Raw Shadow

— U C(lique e arraste o Layer “Raw Total Light” para o topo da lista de
Layers

[ Nalista de efeitos, escolha o “Soft Light”

1 Controle 0 “Opacity” para 21%

Layers Channels Paths  History Gy maTnn®

£ Kind v @@ TORh®

e LA Fill: 100% v
Soft Light v Opacity: 21% | v . o8

(!
Lock: PO i - | Al 100% o E Quarto 01 Scene 1RawShadow.png

| |
. .
o L_ ;] Quarto_01 Scene 1.RawShadow.png o B—=  Quarto 01 Scens 1RawRefecton.png

o _GQ Quarto 01 _Scena 1.Rawlightpng
[

i- Quarto 01_Scene 1.Denciser.png
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25— AJUSTES NO LAYERS DOS CANAIS — Denoiser o EEER R,

0 V-raysalva 3 verstes da imagem ki B 4 B D @ R 0%

o E Quarto_01_Scene 1.RawShadow.png

Q 0 Denoiser que tem uma redugdo de ruidos na imagem

Q  Aimagem normal (possivelmente com alguns ruidos) 0 T quaro 01 scane 1Ramkaiectin.ong

Q  Eoeffectresults, que pode ser descartado O F urto ot scme Lantighiong

' ' . . ' —.T Lpn

L Compare o layer do Denoiser e a imagem originar para selecionar B e
qual ficard ativa o “:1 s 01 S 1. Mierii i

+

O No caso do render do quarto selecionamos 0 a imagem original
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26—

O

O

MUDANDO O TOM DO COURO

No Layer Material 1D selecione com a varinha de conddo a cor que
representa o couro

Caso o Photoshop selecione outras partes ?ue ndo sdo de couro retire
a selecdo pressionando a tecla ATL com as ferramentas de selecdo
mesmo

Com a selecdo demarcada clique o Layer principal da sua imagem e
nos ajustes Jlescolha Hue/Saturation

Diminua a barra da Saturacdo e ela vai agir somente no couro que
haviamos selecionado

Aperte CTRL+D para tirar a selecdo




Sistema de Pos Producao

27- Ajustes com efeitos

O Clique no ajustes Il e escolha “Curves” — esse efeito da uma profundidade
Maior para sua imagem

(1 Para controlar o Curves clique em 2 pontos da linha diagonal e verifique a
intensidade da luz com a varia¢do da curva
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< =@ T O
v | Opacity:| 100% |~

s Y B Rl 100%

; 5 O 'l"r ) Curvac 1
3 Cuidado para ndo exagerar - [= sl

1 Vocé pode controlar a opacidade do efeito também _
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28— Ajustes com efeitos

O Clique no ajustes Il e escolha “Levels” — esse efeito controla a luz na imagem

1 Para controlar o Levels mexa nos 3 pontos de controle que interferem nos tons
claros, médios e escuros da imagem.
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1 Vocé pode controlar a opacidade do efeito também o w3 e
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Properties :

[N u Photo Filter

© Fiter:  Warming Filter (85)

29— Ajustes com efeitos w |
Q Clique no ajustes Il e escolha “Photo Filter” — esse efeito controla a luz na T ——

imagem

1 Para controlar mexa no de controle da Densidade

- BeTORn®

Opacity: 100%

S e Fill: 100%
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30- IMAGEM 2

(JRepita 0 mesmo processo para a 2% imagem do render
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30— Salve seus arquivos

LSalve o0 arquivo de Photoshop no
formato PSD

(Salve como o arquivo em PNG
para inserir na apresentacao




